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Overview 

PI BatchView allows you to view live and historical batch data in PI ProcessBook displays, 

Excel spreadsheets, using a QuickSearch application, and using other containers. With PI 

BatchView you can view batch information stored in your PI Servers. 

The components of PI BatchView are: 

 Batch symbols for PI ProcessBook 

 Microsoft Excel add-in  

 PI BatchView 

 PI BatchView ActiveX controls for searching and displaying batches 

The Batch symbols for PI ProcessBook allow you to display your batch data in PI 

ProcessBook displays. These symbols include a Batch Trend, a Gantt chart, a Results Table, 

and a run-time Search. These components are all tied together within a Batch Group symbol. 

With these tools you can execute simple and complex queries for batches, compare multiple 

batches, trend relevant data from these batches, perform cycle-time analyses, align your batch 

data, and drill down into the sub batches to perform detailed troubleshooting and process 

analysis.  

The Microsoft Excel add-in consists of a set of dialogs and functions that let you incorporate 

batch data in your spreadsheet. 

The PI BatchView QuickSearch is an executable program that allows simple or complex 

searches for batches that you can use without the need to setup a display or a spreadsheet.  

The PI BatchView ActiveX search controls are the foundation for the searches in all the other 

components. They are available to incorporate into special programs that you design for users 

who have PI BatchView installed on their computers. These include all of the search controls 

as well as the Results Table 

 

 

Fixes and Enhancements 

Fixes 

This section lists items that were resolved or added in this release of  PI BatchView 2012 

(v3..1.5.0) 

Punch List Item Description 

14332OSI8  Provides support for systems running with Data 
Execution Prevention (DEP) enabled.  

21591OSI8  The right-click menu behavior is correct for the PI 
BatchView add-in for Excel 2010. Requires 
Office 2010 SP1 or Microsoft hotfix KB 2459118. 

This change has also been implemented for 
Excel 2013.  
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MS12-060  COMCTL32/MSCOMCTRL update is installed by 
the setup kit.  

WI65835  Corrects a problem with PI SDK registry 
permissions  

 

This section lists items that were resolved or added in this release of PI BatchView 3.1.4 

Punch List Item Description 

8269OSI8  The Tag/Alias color scheme was added to allow 
trace colors to be set per tag/alias. The Tag/Alias 
scheme differs from classic, categorized and 
anchored classic color schemes which all define 
colors per batch.  

12119OSI8  PI BatchView QuickSearch has been updated to 
register its connection with the PI Server to 
support PI Server installations with a restricted 
license.  

 

This section lists items that were resolved or added in this release of PI BatchView 3.1.3 

Punch List Item Description 

11502OSI8  Corrections were made for various type library 
problems that were identified due to the 
installation order of PI ProcessBook and PI 
BatchView. The problems included:  
“Compile error: Error in loading DLL” – Seen 
compiling a VB DLL or non-ProcessBook VBA 
(such as Microsoft Excel). This can be a type 
library installation problem if the code 
successfully compiled on a different computer.  
“Error extending symbol. Possible type library 
registration problem.” – Seen in the Message Log 
(using pigetmsg.exe or from the Status Report 
dialog, opened by double clicking on the display 
status icon located on the PI ProcessBook status 
bar).  
“Cannot insert ActiveX control” – Seen when 
either opening a file containing a Batch Group 
symbol or attempting to add a Batch Group 
symbol to a display.   

13282OSI8  Changing levels shown no longer resets 
formatting choices in the PI BatchView for Excel 
Add-in.  

14121OSI8  Corrected Excel groupings when using cell 
references and Excel groupings in the PI 
BatchView for Excel Add-in.  

14832OSI8  Using the PI BatchView for Excel Add-In to 
reference a cell that is either a reference to 
another cell, or a formula, the search results 
returned in Excel are now correct.  

15801OSI8  Changing the indentation options no longer 
causes an exception in some non-English 
languages with the PI BatchView for Excel Add-
in.  

15900OSI8  PI ProcessBook no longer crashes on exit when 
there is an open display with a BatchGroup using 
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a Module Context.  

16047OSI8  The dependency for Microsoft Excel was 
removed when using the PI BatchView for Excel 
Add-in in Microsoft Office SharePoint Server 
2007.  

16061OSI8  The Batch Group symbol bounds were not 
properly initialized for the ThisDislay.Zoom = 
"FitAll" call in time for the first Display.Activate 
event. This problem was introduced with PI 
BatchView version 3.1.1.1. This resulted in PI 
BatchView symbols being drawn too small and 
close together in the top corner of the display. PI 
BatchView was corrected to set the PI BatchView 
symbol's bounds when the display is first opened.  

16085OSI8  The PI BatchView for Excel Add-In now allows 
Zoom/Align definition is identified by the Relative 
– Align and Zoom setting from the Settings tab of 
the Batch Definition dialog. 

16358OSI8  The PI BatchView for Excel Add-In file, 
PIBVExcel.dll, is now digitally signed. 
Consequently, Excel will no longer prompt that 
the add-in contains macros, when macro security 
is enabled.    

16441OSI8  The trend cursor was corrected to show the 
correct time in a negative time scale. The 
problem occurred when a Batch Trend was 
configured to display batch data using a negative 
time scale (for example, 10 minutes before the 
BatchStart time, or -10m). When a trend cursor 
was positioned on the time scale in the negative 
number region, the Time displayed in the cursor 
time box was always in seconds even when the 
time scale duration was displayed in Minutes, 
Hours, Days etc. This problem was introduced 
with PI BatchView 3.1.2.   

17299OSI8  A #NAME? problem was corrected associated 
with starting Excel by double clicking on a file that 
contains a PI BatchView for Excel function. In this 
case, the PI BatchView for Excel functions may 
not have updated until they were recalculated via 
the right click menu, or the PI BatchView for 
Excel Search dialog.    

17751OSI8  Resolved ProcessBook crash when handling 
Results_SelectionChange event. If a selection 
change was made by clicking on the Batch Trend 
and VBA code was used to redefine the traces on 
the Batch Trend, an access violation could result.   

17948OSI8  If the PI server is in the KST (Known Servers 
Table) by IP address, and regional settings have 
thousand separators as periods, a 1004 error 
was reported when pressing OK in the batch 
search dialog. This problem has been corrected.  

18042OSI8  A problem has been corrected with defining the 
end time of the Batch Group plot time as Batch 
Start + some offset (Batch Definition dialog, 
Settings Tab, Plot Time group). In previous 
versions, the end time of running PIUnitBatch 
records would always be the current time of the 
PI server. The problem only occurred for relative 
plots when a Gantt was not defined in the Batch 
Group.  
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18707OSI8  Text in search parameters that can be resolved 
to a cell reference (e.g., r401, cdt158) are 
resolved by Excel as cell references.  If you 
desire to enter a search parameter and need to 
ensure it is not resolved as a cell reference, you 
can start the parameter with a single quote (') 
(e.g., 'r401, 'cdt158).  You can use this both 
within the definition dialog and within cells.  The 
single quote prefix ensures the value is 
interpreted as a string and is the same standard 
that is used by both PI DataLink and Microsoft 
Excel.  

 
SCR# 21627  

 

Setup was corrected to resolve a Windows 
Installer error “The feature you are using is on a 
network resource that is unavailable”. This error 
was encountered when an Administrator installed 
PI BatchView before installing PI ProcessBook, 
and a Restricted user was running it.  
Another symptom of this problem was COM Error 
800404E9 description = ‘’ source = ‘’. Previous PI 
BatchView versions required the administrator to 
uninstall and re-install PI BatchView to correct the 
problem. 
 

 
SCR# 5104  

 

When a PISubBatch is selected on either the 
Gantt or Results, the Batch Trend highlights the 
section of the trace associated with the 
PISubBatch's time range. The selected trace 
highlighting was changed from an animated trace 
to a highlight band surrounding the trace. 
 

 

This section lists items that were resolved or added in this release of PI BatchView 3.11 

Punch List Item Description 

SCR# 13487  Disconnecting a PI server (for example by going 
to the File --> Connections menu and clearing the 
server check box) had the side effect of clearing 
data from all Batch Group symbols on the 
display. The data was cleared from all Batch 
group symbols, even if the symbol did not access 
the disconnected server.   

11327OSI8  A divide by zero error has been corrected in 
association with a minimum trend scale of 0. The 
problem resulted in a Divide by Zero error 
reported by either PIBatchResultsCtrls or VBA. 
This issue was only seen when the tag was zero 
for the entire duration of the trend and was 
caused by improperly clearing a divide by zero 
error.  

4056OSI8  Time into Plot has been corrected to work with a 
start of Batch Start and a negative offset. The 
previous implementation placed the zero axis at 
the beginning of the batch. The correction was to 
move the zero time axis to the far left of the plot.  

12559OSI8  The Run-time error '13': Type mismatch message 
in Excel on open when the first worksheet was 
not a worksheet (e.g. it's a chart) has been 
resolved.  
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11870OSI8  When opening Excel by double clicking on a file, 
the file would not open when the PI BatchView 
Excel add-In was opened. This situation has 
been resolved.  

 

This section lists items that were resolved or added in this release of PI BatchView 3.1 

Punch List Item Description 

10481OSI8  The Align when zooming setting of the Gantt 
symbol is now used when the Plot Time is set to 
Absolute. Previous implementations would only 
use this feature for relative plots.  

8544OSI8  Sub-batch records on the Results and Gantt are 
now ordered chronologically based on the start 
time. For the Results, this causes the sub-records 
of the expanded row to be in chronological order 
from top to bottom. For the Gantt this order is not 
noticed unless the time ranges of the sub-bars 
overlap. The overlapping sub-bars of an 
expanded Gantt bar are displayed in 
chronological order from top to bottom.  

7907OSI8 and 7929OSI8  Various problems have been corrected with using 
the PI BatchView preferences when creating a 
new Batch Group symbol. Previously, the color 
scheme and Results column preferences were 
not honored.  

6753OSI8  More than 12 data sources (tags, aliases, 
datasets) may now be used in a batch group.   

6066OSI8  Toggling the anchor status with the Anchored 
Classic color scheme now toggles back and forth 
between the same two colors.  

5948OSI8  Traces on the batch trend of running batches 
were sometimes drawn with data in the future of 
the running axis. This problem has been 
corrected.  

5917OSI8  In the Classic color scheme, the first pen color 
was skipped and the second pen color was used 
for the first batch. The first pen color is now used 
for the first batch.  

4792OSI8  Silent installation of BatchView_Setup.MSI is now 
supported.  

4451OSI8  Right clicking on a Gantt bar and selecting 
properties opens the properties of the batch item 
represented by the Gantt bar. With this release, it 
is now possible to view the properties of the 
parent of that batch item. For example, from the 
PISubBatch properties dialog, you can now view 
the properties of its parent PIUnitBatch.  

3947OSI8  Problems have been corrected with the Configure 
Results dialog. PI ProcessBook would crash 
when attempting to move a column up or down 
(to change the column order).  

3805OSI8  The "Batches not found" dialog has been 
redesigned for ease of use. This dialog is shown 
when opening a display that has anchored 
batches that were deleted from the PI database.  

3804OSI8  If the end time column was not present in the 
group symbol's results table and the Categorized 
color scheme was used, running batches would 
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not change to a completed color when the batch 
ended. This has been fixed.  

3802OSI8  Changes to the Tags/Aliases in Trend dialog are 
no longer automatically dropped with each 
search. PI BatchView now only restores a trend’s 
build-time definition when the trend or parent 
Batch Group symbol is reverted.   

3725OSI8  Trace data is now shown outside the PIUnitBatch 
object's time range, up to the offset time defined 
on the Settings tab of the Batch Definition dialog.  

3701OSI8  The plot time definition now only appears on the 
Settings tab of the Batch Definition dialog. The 
duplicated references on the Configure Trend 
and Gantt dialogs have been removed.  

3600OSI8  In absolute time mode, zooming on the Gantt 
now zooms to the time range of the selected 
batch objects. The previous version would zoom 
to the selected batch objects, however the time 
range would not be zoomed. It would remain as 
defined in the Plot Time settings. The Plot Time 
settings are seen in the Batch Definition dialog's 
Settings tab. This problem was only seen in 
absolute time mode for time scales using a 
specific start and end time (not Earliest Batch 
Start Time to Latest Batch End Time).  

3567OSI8  The Show parent level menu item (from the Gantt 
right-click menu) is disabled if the parent level is 
already visible on the Gantt.  

3537OSI8  It is now possible to synchronize the time scales 
of two Batch trend symbols within the same 
Batch Group. Previously, a Gantt symbol was 
required to be in the Batch Group in order to 
synchronize any trends. The Batch Group still 
only supports one list of synchronized plot 
symbols (Gantt and/or trends). Additionally, if the 
Gantt is included in the Batch Group, the Gantt 
must be in the synchronized list (you cannot have 
two synchronized trends with a Gantt that is not 
synchronized).  

3486OSI8  Anchored items are no longer erroneously 
removed from the batch group symbol when the 
query is set to Running only.  

3462OSI8  The "Zoom with align" feature has been renamed 
to "Align when zooming".  

3391OSI8  PI BatchView help files have been moved to the 
PIPC\Help directory (with the exception of legacy 
products included with PI BatchView for 
compatibility).  

3389OSI8  Gantt bars that extend beyond the bounds of the 
Gantt symbol have a distinctive "bump-out" to 
indicate the Gantt bar extends beyond the time 
range of the Gantt symbol in the direction of the 
bump-out.  

3279OSI8  Previous versions did not show any Gantt bar 
label when the configuration was to show the 
"Name with PIHeading" and there was no 
PIHeading defined for the PISubBatch. This has 
been corrected to show the Name without the 
PIHeading in this case.  

3206OSI8  The visible flag is no longer changed on an 
anchored batch object when a batch search is 
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executed. Any change made to the visible status 
on the definition dialog appears in the display and 
is saved with the display based logic from the PI 
server to identify when new PIUnitBatch objects 
have been created. Once the new PIUnitBatch 
has been discovered, PI BatchView checks if the 
new PIUnitBatch belongs in its query results 
before adding it to the display. Automatically 
updating the display is controlled by the Update 
Batch Query setting of the Batch Group symbol. 

2770OSI8  PI ProcessTemplates datasets are now 
accessible as Limit Sets within PI BatchView. 
This includes the ability to show the PI 
ProcessTemplates data beyond the end of the 
batch.  

2710OSI8  The hourglass (wait cursor) is now displayed for 
the entire duration when PI ProcessBook is busy 
performing a task (previous versions would flicker 
the hour glass or turn it off prematurely).  

2709OSI8  The data sources added during runtime with the 
trend's right-click menu option "Tags/Aliases on 
trend" were not shown on the trend's legend. 
They are now shown.  

2529OSI8  PISubBatch views of the batch group symbol can 
now be saved with the display.  

11870OSI8  When opening Excel by double clicking on a file, 
Excel would open but the file would not open. 
This problem has been addressed.  

BV79   Spreadsheets with PI BatchView functions that 
were created on one machine and then loaded 
on another machine would report problems with 
the PI BatchView functions if the Excel add-in 
was installed in different directories on each 
computer. This has been resolved with the new 
3.1 Excel add-in's functions, which no longer 
exhibit this problem.  

SCR# 17756   Beginning with PI ProcessBook 3.0.14, the PI 
BatchView 3.0 batch trend right-click menu option 
to revert the trend did not behave correctly. The 
revert could result in incorrectly drawn traces or 
incorrect calculations of the vertical scale. This 
problem has been corrected with PI BatchView 
3.1.  

SCR# 14468  Search for "The First" or "The Last" N batches did 
not account for the number of anchored batch 
objects in the results. The initial search returned 
the correct number of batch objects. However, 
the update logic removed a quantity equal to the 
number of anchored batches in the results from 
the query results in the results list. The update 
logic has been corrected to not include the 
anchored record count.   

      Enhancements 

What’s new in version 3.1.5?  

 Support for Data Execution Prevention (DEP) on operating systems that enable it.  
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What’s new in version 3.1.4?  

 The Tag/Alias color scheme was added to allow trace colors to be set per tag/alias. 

TheTag/Alias scheme differs from classic, categorized and anchored classic color 

schemes which all define colors per batch.  

What’s new in version 3.1.3?  

 This minor version enhancement provides compatibility with PI ProcessBook 

version 3.1.  

 Another benefit of this new version is that you can now use the PI BatchView for 

Excel Add-in without having Microsoft Excel installed on the web server for 

Microsoft Office SharePoint Server (MOSS) 2007. 

What’s new in version 3.1.2?  

 This minor version enhancement provided support for DataLink for Excel 

Services product (for Microsoft Office SharePoint Server 2007). 

What’s new in version 3.1.1?  

 Support for Highly Available PI Servers was added for this minor version 

enhancement. Documentation on this feature is available on the Tech Support 

website in the High Availability User Guide and the High Availability Advanced 

User Guide.  

 Note that this support for Highly Available PI Servers has resulted in dropping 

support for PI2 servers.  

What’s new in version 3.1.0?  

 A new Excel add-in was introduced with full support for the PI Batch Database, 

including PIBatches and PISubBatches.   

 Custom naming of PI Batch terms within the user interface is provided. 

 Integration is provided with PI ProcessTemplates version 1.3.0.7 and later (as 

Limit Sets). 

 The ability to create Gantt chart and Trend showing only PISubBatch data was 

added. 

 The ability to show trace data outside the time range of the PIUnitBatch was 

added. 

 The search features were enhanced so that the Unit Attribute of the search can 

consume PI ProcessBook's Module Context.  

 Several performance improvements, including significant improvements to search 

speed, were introduced. 

 Type Library enhancements for the VBA programmer were added.  

 Other Fixes and Enhancements to the PI ProcessBook, Excel and QuickSearch 

components were addressed. 

Known Issues 

Note in the tables below that SCR# items represent internal references only.  

http://techsupport.osisoft.com/
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Punch List 
Item 

Description Workaround  

 The About Box and other documentation 

references PI Batch View 3.1.4.0 

 

Only the files required to correct 
14332OSI8 & 21591OSI8 have been 

updated. File/version verification can be 
done by inspecting the version of 
SSubTmr6.dll in the About Box file list. 
Version: 3.1.5.0 indicates PI BatchView 
2012.   

Only the files required to correct 
14332OSI8 & 21591OSI8 have 

been updated. File/version 
verification can be done by 
inspecting the version of 
SSubTmr6.dll in the About Box file 
list. Version: 3.1.5.0 indicates PI 
BatchView 2012.  

 

 

  
 
Batch Definition, creating or editing a Batch Group.  
 

Punch List Item Description Workaround 

SCR# 6157 .  While making changes in the 
Tag/Aliases text box (on the Batch 
Definition main tab, Configure 
Trend main tab, or Tag/Aliases 
runtime dialog), select an alias in 
the Available Aliases list box and 
click the "Add Alias" button. This 
sequence of actions causes the 
alias to disappear from the 
Available Aliases text box without 
appearing in the Tags/Aliases text 
box. 

Found in 3.0.  Re-edit the Batch 
Group symbol, making sure to not 
add an alias while editing a 
Tags/Aliases list entry. 

SCR# 15319  If an entry is manually added to 
the Tags/Aliases list while the 
"Working..." status is shown on 
the Available Aliases control, the 
entry is lost from the Tags/Aliases 
list box when the "Working..." 
status is removed.  

Found 3.1.0. Re-add the entry 

 
SCR# 15907  

 

There may be problems undoing 
an edit of the BatchGroup symbol. 
Some runtime actions are not 
restored with the undo action. For 
example selection, anchor state, 
visible state, expanded state of 
results and expanded state of the 
Gantt bars.  

Found 3.1.0. No workaround 
available. 

 
Batch Group Navigation  
 

Punch List Item Description Workaround 

SCR# 6726  Multiple batch selection is partially 
available in this release. Multiple 
rows may be selected on the 
Results for the purpose of 
changing the visible or anchored 
status on multiple rows at a time. 

Found in 3.1.0 . No workaround 
available 
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However, the Gantt bar and trace 
only reflect (highlight) the most 
recent selection in the Results 
table.   

 
Excel Add-in 
 

Punch List Item Description Workaround 

_____ In Manual mode, when a PI 
BatchView query is executed, the 
data returned is not formatted until 
an Excel calculation is performed. 
This includes the initial query as 
well as any time "Recalculate" is 
selected from the right-click menu. 
A manual Excel calculation can be 
done by pressing F9. 
 

Found in 2.1  No workaround 
available 

10551osi8 If a BatchView formula is selected 
and dragged to another location 
on the screen, the formatting and 
grouping is not removed at the old 
location. The formatting output at 
the new location is correct.   

Found in 3.1.0. No workaround 
available 

SCR# 23133 If the following message appears 
when Microsoft Excel opens, the 
PI BatchView application has 
been removed from the computer. 
“PIBVExcel.xla could not be 
found. Check the spelling of the 
file name, and verify that the file 
location is correct. If you are trying 
to open the file from your list of 
most recently used files, make 
sure that the file has not been 
renamed, moved, or deleted.”  
If Microsoft Excel is installed on a 
machine when PI BatchView is 
installed and then PI BatchView is 
later removed, Microsoft Excel 
continues to look for the add-in 
when it opens.. 

Found in 3.1.2. Manually remove the 
add-in from Excel. Open the Excel 
Options dialog by pressing the Excel 
Options button from the Windows 
Orb menu in the upper left corner of 
the Excel window or select Add-ins 
from the Tools menu of older 
versions of Excel. Choose Add-Ins 
from the left side column of options. 
Select Excel Add-ins from the drop 
down list beside the word “Manage:” 
at the bottom of the dialog and press 
the Go. This will retrieve the Add-Ins 
dialog and Pibvexcel will be on the 
list with a check mark. Select the row 
for Pibvexcel and the system will say 
that it cannot find this add-in and 
suggest you delete it. Choose to 
delete the add-in. 

18477OSI8 When right-clicking on an existing 
BatchView search result in Excel 
2007, with DataLink 4.0.3 
installed, the BatchView specific 
menu items may not display in the 
context menu.  

Found in 3.1.3. If the context menu 
does not have the BatchView 
specific items in it, select a cell in the 
BatchView search results and from 
the PI menu select BatchView.  This 
will populate the BatchView search 
window with the parameters from 
your existing BatchView search 

----- The order of loading the PI 
Datalink and PI BatchView Excel 
add-ins may be causing problems 
if you receive one of the following 
two errors:  
“The macro 
‘PIBVBatchSearchDialog’ cannot 
be found,” or  
“The macro 

Found in 3.1.0.  To correct this 
situation, open the Tools menu and 
select Add-Ins. Clear the PI-
DataLink check box and click OK. 
Exit and then restart Microsoft Excel. 
Reselect the PI-DataLink check box 
in the Add-Ins dialog. 
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‘pidldialogs.xla!PIBVBatchSearch
Dialog’ cannot be found,” 

----- When opening Excel you may see 
an SDK repair dialog. The repair 
is ineffectual and happens each 
time you open Excel. This 
situation occurs when the .NET 
Framework 1.1 is not installed and 
you are using Excel 2003 or 
earlier (without the Microsoft 
KB907417 patch). You do not see 
this problem if you are using Excel 
2007.   

Found in 3.1.1. Installing .NET 
Framework 1.1 fixes this problem for 

all cases (download from 

Microsoft). Alternatively, for Excel 
2003, you can fix the problem by 
installing Microsoft's KB907417 

patch (download from Microsoft). 

----- Spreadsheets created with PI 
BatchView 3.1.2.0 and later are 
not backward compatible with 
versions of PI BatchView earlier 
than 3.1.2.0. 

Found in 3.1.2.  No workaround 
available 

------- The spreadsheet cells contain the 
text “#NAME?” instead of the 
actual data. 

Foun din 3.1.3. The solution is to 
manually add the 
PIBVExcel.Functions add-in to 
Excel. Open the Excel Options 
dialog by pressing the Excel Options 
button from the Windows Orb menu 
in the upper left corner of the Excel 
window or select Add-ins from the 
Tools menu of older versions of 
Excel. Choose Add-Ins from the left 
side column of options. Select Excel 
Add-ins from the drop down list 
beside the word “Manage:” at the 
bottom of the dialog and press the 
Go. This will retrieve the Add-Ins 
dialog. If PIBVExcel.Funtions is on 
the list then place a check mark 
beside this entry and click OK. If 
PIBVExcel.Functions is not on this 
list then press the “Automations” 
button, select PIBVExcel.Functions 
from the dialog that appears, and 
click OK. 

------- "#NAME?" errors may appear in 
some cells when you open an 
Office Excel 2007 .xlsx or .xlsm 
file in an earlier version of Excel.   

See Microsoft Support Article ID# 
945828. 
http://support.microsoft.com/?id=945
828 

------- The PIBVExl.hlp help file will not 
work with a standard Vista or 
Server 2008 installation.   

Found  in 3.0. Users may download 
software from Microsoft to address 
this limitation. For Vista, see 
http://www.microsoft.com/downloads
/details.aspx?FamilyID=6ebcfad9-
d3f5-4365-8070-
334cd175d4bb&displaylang=en. For 
Server 2008, see: 
http://www.microsoft.com/downloads
/details.aspx?familyid=0468fefd-
b54f-4c57-8340-
c6dd2ec20c0a&displaylang=en&tm 

 
 

http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-f589-4842-8157-034d1e7cf3a3&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=1B0BFB35-C252-43CC-8A2A-6A64D6AC4670&displaylang=en
http://support.microsoft.com/?id=945828
http://support.microsoft.com/?id=945828
http://www.microsoft.com/downloads/details.aspx?FamilyID=6ebcfad9-d3f5-4365-8070-334cd175d4bb&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=6ebcfad9-d3f5-4365-8070-334cd175d4bb&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=6ebcfad9-d3f5-4365-8070-334cd175d4bb&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=6ebcfad9-d3f5-4365-8070-334cd175d4bb&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=0468fefd-b54f-4c57-8340-c6dd2ec20c0a&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=0468fefd-b54f-4c57-8340-c6dd2ec20c0a&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=0468fefd-b54f-4c57-8340-c6dd2ec20c0a&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=0468fefd-b54f-4c57-8340-c6dd2ec20c0a&displaylang=en&tm
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Gantt 

Punch List Item Description Workaround 

-------- When aligning to a PISubBatch 
Gantt bar that does not have a 
matching PISubBatch under some 
of the other PIUnitBatch Gantt 
bars, the non-matching 
PIUnitBatch Gantt bars are 
aligned to the start time of the 
PIUnitBatch. If the PIUnitBatch is 
running, alignment occurs when 
the matching PISubBatch is 
started.   

Found in 3. 0 . No workaround 
available 

SCR# 17582 If a PISubBatch is longer than its 
parent (either a PIUnitBatch or a 
PISubBatch), trace data outside 
the parent will not be shown on 
the trend 

Found n 3.0. Either on the Gantt 
chart zoom to the longer 
PISubBatch or to a level above it if 
possible. Or Expand the Gantt to 
the desired PISubBatch and then 
right-click the trend and select 
Revert.   

 

SCR 6340 The PI ProcessBook Change 
Time Range dialog, Scroll Time 
toolbar item, One Time Period 
Forward and One Time Period 
Back features have no affect on 
the Gantt. 
 

Found in 3. 0 . No workaround 
available  
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General 
 

Punch List Item Description Workaround 

SCR# 10121  The Custom Placeholders dialog 
is launched as non-modal. If the 
parent dialog is selected when the 
custom placeholders dialog is 
open, the resulting errors crash PI 
ProcessBook.  

Found in PB 30. None  

SCR# 15019  Custom Name Settings may be 
changed in the “Custom Name 
Settings” dialog. The settings 
dialog is launched by running 
CustomNamesSettings.exe, 
located in the \PIPC\Batch 
directory. The option “Enable 
Custom Names for this user” does 
not take effect for Batch Group 
symbols on displays that are 
already open in PI ProcessBook. 
In addition, changes to the custom 
name settings are not reflected on 
the PI ProcessBook Preference 
dialog until the dialog is closed 
and reopened. 

Applying the setting may require 
using revert or reloading the 
display. If selecting the Batch 
Group symbol and selecting Edit-
>Revert does not work, close the 
display and re-open it 

SCR# 15018 Custom Name changes on the PI 
Server are not communicated 
immediately to the client PC. PI 
ProcessBook, PI BatchView 
QuickSearch and Microsoft Excel 
(using the PI BatchView Add-in) 
may require you to re-launch the 
application or reload the file. 
 

Found in PB 30. Re-launch the 

application or reload the file. 
 

 

SCR# 15780  The 'None' color is not handled 
correctly by the Batch Group 
symbol. Various problems have 
been noticed ranging from using 
the color 'Black' in place of 'None', 
to message boxes and a crash. 
Avoid using the color 'None'.  

Found in PB 30. None 

SCR# 19305  Changing a PI ProcessBook 
display's time zone from Client to 
Server (or vice versa) does not 
update all times displayed on the 
Batch Group sub-symbols.   

To ensure the batch symbols have 
been updated after the time zone 
is changed, revert the Batch 
Group symbol or the display.  

-  The PI BatchView 2.1 templates 
for formatting the BatchTrend are 
not available in version 3.x. 
Version 2.1 trends retain their 
configured formatting, but 
templates cannot be applied to 
new symbols in version 3.x.  

None  

SCR# 27582  PI BatchView causes PI 
ProcessBook to leak 2 GDI 
resources each time a display is 
closed that contains a Batch 
Group symbol. The leak equates 
to approximately 2kB of memory.  

None  

SCR# 27957 Selecting the X button to close the Found in PB 31.0. The problem is 
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QuickSearch Options dialog 
removes all the columns from the 
Results control on the 
QuickSearch dialog. The missing 
columns can cause QuickSearch 
to crash. The problem is caused 
because the columns are all 
removed by pressing the X button. 
Similar problems are also seen if 
the columns are deliberately 
removed from the options dialog 
(and OK is pressed) 
 

avoided if the Options dialog is 
closed using either the Cancel or 
OK button. 

 

 

18714OSI8  A .NET addin to PI ProcessBook 
which uses one of the BatchView 
COM interop assemblies will fail 
after upgrading PI ActiveView 
3.0.x to PI ActiveView 3.1.0.2. The 
upgrade results in removing the 
interop assemblies from the GAC. 
These entries are reinstated when 
a repair to PI ActiveView 3.1.0.2 is 
executed.   Assemblies removed 
from the GAC on upgrade are: 
OSIsoft.AxPIBatchResultsCtrls.dll, 
OSIsoft.PIBatchCommon.dll, 
OSIsoft.PIBatchDialogs.dll, 
OSIsoft.PIBatchResultsCtrls.dll 
and OSIsoft.PIBatchSearch.dll.  

These entries are reinstated when 
a repair to PI ActiveView 3.1.0.2 is 
executed.     

 
Limit Sets (PI Process Template Integration) 
 

Punch List Item Description Workaround 

SCR# 15015  PI BatchView does not correctly 
integrate with PI 
ProcessTemplates based on 
PISubBatch time ranges. The 
duration of the PI 
ProcessTemplates data is 
assumed to begin at the 
beginning of the PIUnitBatch. 
This may result in missing part 
or all of the PI 
ProcessTemplates data on the 
trend.  

Found in 3.1.0. None  

-  "Error during future trend 
refresh Type mismatch". PI 
BatchView only supports PI 
ProcessTemplates version 
1.3.0.7 and later. Earlier 
versions of PI 
ProcessTemplates produce this 
error message.  

Upgrade to PI ProcessTemplates 
version 1.3.0.7 or later.  

SCR# 15740  Pressing the Tab key on the 
Import Limit Set dialog appears 
to lose the selection. Clicking 
OK imports the previous 
selection.  

None  

SCR# 16045  Zooming to PI 
ProcessTemplates data in the 

None  
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future may result in no data 
shown for the PI 
ProcessTemplates. This 
problem was discovered using 
version 1.3.0.4 of PI 
ProcessTemplates.  

SCR# 16051  Double-clicking a .pdi (or .piw) 
file to launch PI ProcessBook 
with the file may fail loading the 
file. PI ProcessBook launches, 
but the display is not loaded. 
Note, this failure happens with 
any .pdi or .piw file (even if PI 
ProcessTemplates is not used 
by the file). This failure occurs if 
the PI ProcessTemplates add-in 
is configured to "Load on 
Startup" and the PI server used 
by PI ProcessTemplates 
requires the connection dialog 
be displayed for login 
credentials. This problem was 
found with PI ProcessBook 
version 3.0 and is scheduled to 
be fixed with a future version of 
PI ProcessBook.  

Found in PB 3.0 To work around 
the problem, load the display after 
the PI ProcessTemplates add-in 
has been loaded.  

------- The limit set feature is designed 
only to work with PIUnitBatch 
results against a single PI unit. 
Displaying multiple PI units in 
the results may lead to 
misaligned or missing limit data. 
 

None 

------- No PI ProcessTemplates data is 
shown in PI ProcessBook 3.0 
for a running PIUnitBatch if the 
time zone of the client PC is 
ahead of the time zone of the PI 
server, i.e., the time zone of the 
client is east of the time zone of 
the server. For the Batch Trend 
symbol, this may result in no 
limit set data shown. This 
problem has been corrected 
with PI ProcessTemplates 
version 1.3.0.8. 
 

PT 1.3.0.7  
Upgrade to PI ProcessTemplates 
version 1.3.0.8 or later. 
 
 

------- Limit Set traces ignore offsets to 
the end time such as BatchEnd-
10 minutes. The Limit Set 
always shows data to the end.  

None  

------- PI ProcessTemplates uses the 
API to connect to a PI server. 
Since PI ProcessBook version 
3.0 no longer uses the API, you 
may need to set 
ConnectUsingAPI=1 in the 
[startup] section of the 
procbook.ini. When the value of 
ConnectUsingAPI is set to 1, PI 
ProcessBook allows a 

None  
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connection to the default PI 
server using the PI API. This 
setting synchronizes PI API 
server connectivity with PI SDK 
server connectivity. If a server is 
connected with the PI SDK, the 
server is connected with the PI 
API. The converse does not 
occur; namely, if a connection is 
made through the PI API, that 
connectivity is not provided 
through the PI SDK. In addition, 
it is up to the user to maintain 
the PILOGIN.INI file, used by 
the PI API, with servers that are 
in the Known Servers Table 
maintained by the PI SDK.  

 
PI ProcessBook Display 
 

Punch List Item Description Workaround 

------- If a display created with PI 
ProcessBook 2.1 and PI 
BatchView 2.1 is loaded on a 
system with PI ProcessBook 2.2 
or 2.3 without PI BatchView, the 
PI BatchView symbol displays as 
a blank box with the name of the 
symbol. However, if the display is 
then saved, PI ProcessBook 2.2 
and 2.3 with PI BatchView 2.1 
crashes when attempting to open 
the display. The same display 
may be opened with PI 
ProcessBook 2.3 and PI 
BatchView 3.x. However, the 
configuration information for the 
batch trend is lost.  

None  

------- The ToolTip of the "Batch Group" 
drawing toolbar button shows 
"Batch Trend" if the system was 
upgraded from PI BatchView 2.1.   

To correct the problem, right-click 
on the Toolbar area of PI 
ProcessBook, select 
"Customize..." from the right-click 
menu, highlight the "Drawing 
Toolbar" item in the Toolbars list 
box and click the Reset button.  

------- The PI BatchView symbols are not 
saved when the SVG file format is 
selected.  

None  

18116OSI8  Opening ProcessBook displays 
with a batch group symbol may 
result in seeing COM Error: 
8004AF14 description = 'Registry 
item not found in the collection' 
source = 'PISDKRegistry.dll'. 
Additional symptoms are seeing 
strings containing a GUID in the 
Connections dialog such as 107 
{4572DB6F-FB4B-4BA4-92E2-
1811DAA61D7B} \1\?0\58 
{4572DB6F-FB4B-4BA4-92E2-

This problem is seen when the 
Automatically add unknown 
servers option is enabled, but the 
Resolve network name before 
adding option is disabled in the 
Connection Options dialog (File-
>Connections->Tools->Options). 
To resolve the problem, either 
check both options, or un-check 
both options.   
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1811DAA61D7B} 
\1\?37473\piservername or 58 
{4572db6f-fb4b-4ba4-92e2-
1811daa61d7b} 
\1\?37473\piservername. The 
same GUID string may be seen as 
selected in the servers dropdown 
list from the Batch Definition 
dialog. Note that the GUID string 
may be seen in the batch group 
symbol's Batch Definition dialog if 
the server is an unknown PI 
server. However, seeing the GUID 
in both the Batch Definition dialog 
and the connections dialog is an 
indication of this problem. 

 
PI ProcessBook Display (file) Backward Compatibility  
 

Punch List Item Description Workaround 

------ You may see the following error 
on systems running PI BatchView 
2.1: Unable to exit design mode 
because control 'pbBatchCriteria' 
cannot be created. This error 
message is only seen on systems 
with PI BatchView 2.1. The error 
is seen when attempting to load a 
display with a PI BatchView 3.x 
BatchGroup symbol on a system 
with PI ProcessBook 2.3 and PI 
BatchView 2.1. This problem has 
been corrected with PI 
ProcessBook 2.31.  

None 

------ You may see the following error 
on systems running PI BatchView 
2.1: Compile error: Can't find 
project or library. This error 
message is only seen on systems 
with PI BatchView 2.1. The error 
is seen when attempting to load a 
display with a PI BatchView 3.x 
Batch Group symbol on a system 
with PI ProcessBook 2.2 and PI 
BatchView 2.1.  

None 

------ The Plot Time (or Time Alias) 
definition from PI BatchView 2.1 is 
not updated based on the current 
definition of the Plot Time 
definition in PI BatchView 3.x. The 
settings remain as they were 
defined in PI BatchView 2.1 (or 
default to relative plot of batch 
start to batch end, if never edited 
with PI BatchView 2.1).  

Found in 3.0.  No workaround 
available.  

------ Some displays created with PI 
BatchView 3.1 Beta are not 
compatible with PI BatchView 3.0 

Some displays created with PI 
BatchView 3.1 Beta are not 
compatible with PI BatchView 3.0 
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and crash PI ProcessBook if an 
attempt is made to open the 
Configure Results dialog from the 
Layout tab of the Batch Definition 
dialog. This problem only affects 
displays that have a Results table 
that has been edited using the 
Edit button in the Configure 
Columns dialog of the Beta.   

and crash PI ProcessBook if an 
attempt is made to open the 
Configure Results dialog from the 
Layout tab of the Batch Definition 
dialog. This problem only affects 
displays that have a Results table 
that has been edited using the 
Edit button in the Configure 
Columns dialog of the Beta.   

 
 
Results  
 

Punch List Item Description Workaround 

SCR# 5746  Using Edit->Selected item when 
either the Gantt or Trend is 
maximized results in the Search 
and/or Results symbols "bleeding" 
through the maximized symbol 
when the definition dialog is 
closed.   

Found in 3.0. Double-clicking the 
maximized symbol to minimize it 
fixes the problem.  

SCR# 18624  The Results table is stretched if its 
display is opened by double 
clicking on it (from Windows 
Explorer, or the desktop) and PI 
ProcessBook is minimized. The 
problem is more pronounced the 
smaller the PI ProcessBook 
display area is in comparison to 
the size of the Batch Group 
symbol. The problem is seen if PI 
ProcessBook is open and 
minimized. 

Found in 3.1.0. To correct, close 
and reopen the file.  

SCR# 19653  The results portion of a Batch 
Group symbol may be stretched 
larger than its original size when 
its display is opened as 
maximized and the PI 
ProcessBook display area is 
small.   

Found in 3.1.0. To workaround 
this problem, maximize PI 
ProcessBook (to increase the 
display area) and reopen the 
display.  

SCR# 15509  The definition of a Tag column in 
the Results table supports 
absolute tag references such as 
'\\mypiserver\sinusoid'. If such a 
column is defined in a PI 
ProcessBook Display and the user 
substitutes another PI server 
(perhaps since the PI server was 
renamed or migrated to a new 
machine) that substitution is not 
supported for the column.   

Found in 3.1.0. The user must 
manually edit the absolute tag 
reference in the column.  

SCR# 20880  The formats for Start and End 
Time columns set in the Results 
(in either symbol configuration or 
PI BatchView preferences) are not 
applied to the Results control. The 
PI ProcessBook time preference 
(on the Start tab of the PI 
ProcessBook Preferences dialog) 
overrides the Start and End Time 

Found in 3.0. No workaround 
available. 
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format column preferences.   

12548osi8  The standard PI PE Expression 
syntax used in Expression 
columns in the Results Table is 
limited in its use of [S] and [E] 
placeholders for the start and end 
times of a batch item during a 
daylight savings change. 
Assuming a DST transition at 2:00 
am, if either of these placeholders 
evaluates to a time between 
1:00:00 and 1:59:59 BEFORE the 
daylight savings Fall/Autumn 
change, the time is interpreted on 
the server as being the same time 
AFTER the change. In this case, 
the times evaluated are incorrect 
by the daylight savings difference 
(usually 1 hour).  

Found in 3.1.0. None  

------ There is a problem with loading a 
display with a BatchGroup that 
was created using the PI 
BatchView 3.1 beta into PI 
BatchView 3.0.x. If the 
BatchGroup’s Results table is 
visible and one or more of its 
columns have a caption defined, 
then attempting to open the 
Configure Results dialog from the 
Layout tab in the BatchGroup 
Definition dialog causes the dialog 
and PI ProcessBook to crash. 

The display can be fixed by 
loading it into PI BatchView 3.1, 
removing the columns that have 
captions defined, saving the 
display, re-adding the columns 
and their captions and then saving 
the display again. 
 

------ Existing displays created with PI 
BatchView 3.1 Beta 1 that used 
the expression column type with 
the placeholders “|S|” or “|E|” 
show an error in each cell of the 
column. The placeholders are now 
“[S]” and “[E]”. 
 

Update existing displays to use 
the new placeholders. 
 

 
SCR# 22735  

 

The instruction at "…" referenced 
memory at "…". The memory 
could not be "written".  
Error message is seen closing 
ProcessBook after launching the 
dialog to Edit Column Attributes 
from the Configure Results dialog. 
 

The error occurs after PI 
ProcessBook has finished saving 
and is shutting down. The error 
can be ignored. 
 

 
Search 
 

Punch List Item Description Workaround 

SCR# 21625  Clicking some areas of the Search 
symbol (in run mode) does not 
select the Batch Group symbol.  

None  

SCR 21626 In some cases, the batch group 
symbol’s Build mode right click 
menu appears when right-clicking 
on some areas of the Search 
symbol (in run mode).   

Found in 3.0 . No workaround 
available.  
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------- The value “*-2 min” is not 
accepted as a valid “time from” or 
“time to” in PI BatchView 
searches. Use “*- 2 m” or “*-2 
minutes” as a substitute.  

Found in 3.0 . No workaround 
available. 

SCR# 5746  Using Edit->Selected item when 
either the Gantt or Trend is 
maximized results in the Search 
and/or Results symbols "bleeding" 
through the maximized symbol 
when the definition dialog is 
closed.   

Double-clicking the maximized 
symbol to minimize it fixes the 
problem.  

SCR# 7752  The Search controls show up with 
black areas in the PI ProcessBook 
print preview. The print functions 
correctly.  

Found in 3.0. None  

SCR# 16276  Lost "Redo Search Criteria 
change" action from redo queue. 
Problems have been identified 
with undo operations associated 
with changing the Include state of 
the search on the display. For 
example, if you change the 
Include option (Running, 
Completed, Both) on the display, 
select Undo Search Criteria 
change, and click on the undo 
drop-down list to view the undo 
queue, the "Redo Search Criteria 
change" option is lost.  

Found in 3.0. None  

SCR# 18162  Layout problems have been 
noticed with long Custom Names 
for the "Search Criteria". The 
problems result in the server pick 
list not being seen on the Batch 
Definition dialog and on the 
Search Symbol.   

Found in 3.1.0 Care should be 
taken in assigning long Custom 
Names for the "Search Criteria" 
Custom Names to avoid layout 
issues.  

 
SCR# 13294  

 

 
When resizing a PI 
ProcessBook display to sizes 
less than 100% using the Zoom 
property, the Search symbol 
does not decrease in size 
proportionately. This may result 
in overlap with other symbols. 
This may also be evident when 
viewing the display in PI 
ActiveView.  

 

 
Found in 3.0 . To avoid this 
issue, leave extra space below 
the Search symbol in the 
display.  

 

 
11117 OSI8  

 

 
Windows long date format is 
not accepted as a valid format 
for search times. For example, 
"Tuesday, May 23, 2006 4:00 
AM" returns an error.  
In general, ProcessBook 
accepts the Windows Short 
Date format configured on the 
computer where ProcessBook 
is running.  

 

 
Found in 3.0 If you remove the 
commas, as in "Tuesday May 
23 2006 4:00 AM", this date 
format is accepted.  
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Setup/Uninstall 
 

 

 

Trend  

Punch List Item Description Workaround 

----------- If you are upgrading from a 
version of the PI SDK prior to 
1.3.1.225, you may observe the 
following behavior. When 
installing PI BatchView, Windows 
Installer opens a background 
dialog box for a portion of the 
installation, then a progress bar, 
then another Windows Installer 
dialog. The Windows Installer 
dialogs have only a cancel button. 
When the install is complete, all 
the windows close. This problem 
does not happen on a new 
installation of the PI SDK.  

None 

----------- When PI BatchView is uninstalled,  
the Excel Add-in is not removed 
from Microsoft Excel's add-in list. 
When Excel is opened after a PI 
BatchView uninstall, an error is 
displayed stating that the PI 
BatchView add-in (PIBVExcel.xla) 
cannot be found. 

 

 

To resolve this error:  
Select "Add Ins…" from the Tools 
menu of Excel.  
Clear the Pibvexcel checkbox. 

  

 

SCR 22197 After installing PI BatchView on 
Windows Vista the user sees an 
error when opening the Control 
Panel\Programs and Features, 
and right-clicking on PI 
BatchView, choosing “Change”, 
then choosing either “Repair” or 
“Remove” on the PI BatchView 
version 3.1.1.1 Setup Dialog. The 
system attempts to perform the 
action and then encounters the 
error: “Error 1606. Could not 
access network location NULL.” 
This happens only when using 
Windows Vista and only when the 
User Account Control in the 
Control Panel\User Accounts is 
turned on.  

Found in 3.1.1.. One workaround 
is to open the User Accounts in 
the Control Panel and turn User 
Account Control off. Alternately, 
the user can select “Repair” or 
“Uninstall” directly from the right-
click PI BatchView menu in 
Control Panel\Programs and 
Features without choosing 
“Change” and the action performs 
without error.  

Punch List Item Description Workaround 

----------- Phase and Step markers (a PI 
BatchView 2.1 feature) are no 
longer supported. The Gantt chart 
replaces and expands upon this 
functionality.  

Found in 3.0.  None 

SCR# 19635  If there are too many traces on the Found in 2.1. Increase the size of 
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trend, the trend may not be able to 
display a trend cursor (because 
there is not enough room to show 
all the trace values).   

the trend until the cursor can be 
seen. If a cursor was created on 
the Gantt, but not seen on the 
trend, double-click on the trend (in 
run mode) to maximize the trend 
and see the cursor.  

SCR# 17794  Non-fixed time units behave the 
same as fixed. The time units are 
defined in the Plot Time frame of 
the Settings tab on the Batch 
Definition dialog. Non-fixed time 
units should allow the plot to use a 
smaller time unit as the plot is 
zoomed into smaller time ranges. 
Only fixed time units should 
remain in the specified time units 
as the plot is zoomed into a 
smaller time range.  

Found in 3.1.0  None  

SCR# 6430  The PI ProcessBook Change 
Time Range dialog and Scroll 
Time toolbar item do not affect 

either the Gantt or Trend symbols. 
The One Time Period Forward 
and One Time Period Back 
features only affect the Trend after 
it has been zoomed to a smaller 
time range (from a click and drag 
action on the plot area of the 
trend).  

Found in 3.0.  None  

 
SCR# 27130  

 

 
The batch trend does not 
currently show trace data from 
AF datasets. Problem identified 
with AF dataset version 2.0.0.1 
(installed with PI ProcessBook 
3.1) and the AF dataset 
included with the AF Modeler 
version 1.2.0.  

 

 

 
Found in 3.13. None  

 

SCR# 27169  Improper trace alignment can be 
seen on a batch trend on when 
the Gantt contains data from two 
different PI servers and each has 
a different Time Zone (and/or 
daylight saving time difference). 
The problem is only seen when 
the trend contains trace data from 
only one of the PI servers. For 
example a Batch Group is 
configured to search for 
PIUnitBatch objects with unit 
name “reactor1” and the alias 
“temp” is assigned. The search 
must be against two PI servers 
(each in a different time zone). 
The alignment problem is seen if 
reactor1 PIUnitBatch objects are 
found on both PI servers, but the 
temp alias can only be resolved 
against the PIUnitBatch objects 
from one of the PI servers.  

Found in 3.11.  None  
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Update Batch Query 

Punch List Item Description Workaround 

-  There are two types of logic used 
to update the query results. The 
two types are (1) based on server 
events and (2) based on polling 
the server for updates. The 
preferred method is based on 
server events and is used when 
possible. Due to performance 
issues, the server event method 
cannot always be used. In which 
case, polling is used. Server 
events are used with PI 3 servers 
for:  
PIBatch searches.  
PIUnitBatch searches, where 
specific units are specified for the 
unit, for example 
"\\pi\plant\reactor7". If masks are 
used, such as a "*" or "reactor7" 
or "reactor*", polling is used for 
query updates.  

   

-  Limitations of polling for server 
updates:  
For the purpose of performance, 
the refresh logic checks for 
updates less frequently for 
expensive queries. For each 
second that a query takes, the 
refresh logic waits a minimum of 
65 seconds before checking 
again. Most update queries are 
not that expensive; exceptions 
include:  
Queries for “The first n” batch 
records.  
Queries for completed batches 
that Start between To Time and 
From Time.  
Queries against PI servers that 
have a slow response time.  
If a batch object (PIBatch, 
PIUnitBatch) is added on the PI 
Server after its start time, the 
refresh logic most likely does not 
see it. The reason for this is that 
the logic is constantly checking 
(based on the query used) for top 
level query objects (PIBatch, 
PIUnitBatch) that started in the 
last few seconds. Unless the 
batch item has a start time that is 
at the same time or after it is 
added to the database, refresh 
query logic does not find it. Click 
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VBA/Type Library for PI BatchView 

Revert Time Range or run the 
search again to see these 
batches.  
If an EvalDelay is used with 
pibagen, then the user needs to 
click "Revert Time Range" or run 
the search again to see new 
running batches.  

  
Limitations of Batch Subsystem 
(BSS) event updates:  
Unless the PIUnitBatch objects 
are generated by the Batch 
Database (BDB), no events are 
received from the PI server 
when the PIUnitBatch changes. 
PI BatchView gets updates for 
BSS generated PIUnitBatches 
by periodically retrieving the 
data from the PI server. 
Because this is process 
intensive, only the running 
PIUnitBatches are updated. 
BDB generated PIUnitBatches 
in the same batch group 
continue to receive update 
events from the server.   
  

 

 

SCR# 15812  Results records that are marked 
as invisible on the Batch Definition 
dialog do not receive any updates 
on the display.   

   

SCR# 16074  If a running batch record is 
anchored on the Batch Definition 
dialog and OK is clicked to exit the 
dialog after the batch has 
completed, the batch object 
shows as running on the display. 
“Revert time ranges” does not 
correct this problem.   

 

Punch List Item Description Workaround 

-  The BatchTrend object 
(IDualBatchTrend interface) of the 
PIBTPB type library (btrend.tlb) 
has a binary incompatibility with PI 
BatchView version 2.1's type 
library. The properties and 
methods Rotation, Visible, 
Enabled, EnableScript, 
CreateMultiState and FlipType 
were added to the interface. This 
issue does not affect VBA code, 
only code that is compiled against 
the type library. To maintain 
backward compatibility with PI 

None  
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BatchView 2.1, compile using the 
PI BatchView 2.1 type library.  

SCR# 18451  The Trend and BatchGroup fire the 
TimeRangeChanged event 
whenever an event occurs that 
might change the time range. The 
current logic does nothing to filter 
out firing events when the new 
time range is the same as the old.  

None  

SCR# 18456  MouseOut, MouseOver and 
ToolTipText events are defined for 
the Gantt symbol, but are never 
fired. The same events are not 
defined for the Group or Batch 
Trend symbols.  

None  

SCR# 17260  When the BatchTrend.DropCursor 
event is fired, the cursor parameter 
is not correctly initialized before 
the event is fired. This situation 
results in:  
DroppedCursor.Values.Count has 
a count of 0 the very first time the 
cursor is dropped.  
DroppedCursor.Time always has 
the time of the previous cursor 
position. If dropped for the first 
time, the time is 1/1/1970 12:00 
am, GMT.  
DroppedCursor.Values collection 
contains the values of the traces at 
the previous cursor drop point.  
The BatchTrend.Cursors collection 
also contains the cursor values 
from the previous location.  
If you want the cursor values at the 
new location, look at the values 
after the DroppedCursor event 
completes. Either use a timer or 

Display.DataUpdate event to look 
at the Cursor object after the event 
was fired. For example:  

Private LastDrop As  

 

PIBTPB.IDualCursor  

 

Private Sub 

BatchTrend1_DropCursor( 

_  

ByVal DroppedCursor As 

_  

PIBTPB.IDualCursor, _  

ByVal Time As String)  

Set LastDrop = 

DroppedCursor  

End Sub  

Private Sub 

Display_DataUpdate()  

Dim x As 

PIBTPB.IDualCursor  

If Not (LastDrop Is 

Workaround identified in 
description.  
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Nothing) Then  

Dim i As CursorValue  

For Each i In 

LastDrop.Values  

Debug.Print i.Time, 

i.Value  

Next  

Set LastDrop = Nothing  

End If  

End Sub 

 
 

SCR# 18723  The BatchTrend.BackgroundColor 
property does not update batch 
trend's background color until the 
trend is reverted. To workaround 
this problem, either revert the trend 
after setting the color. Or, use 
BatchTrendDef.Formats.Elements(
pibvFBackGround) to change the 
background color. For example:  
Private Sub 

ChangeBackground()  

  Dim newDefinition As 

BatchTrendDef  

  Set newDefinition = _  

    

BatchTrend.GetDefinitio

n  

  Dim elem As element  

  Set elem = _  

    

newDefinition.Format.El

ements( _  

    pibvFBackGround )  

  elem.Color = 

pibvWhite  

  

BatchTrend.SetDefinitio

n _  

    newDefinition  

End Sub  

Workaround identified in 
description.  

SCR# 18724 Moving the BatchGroup symbol, 
using the Top or Left properties, 
does not always erase the batch 
Gantt and Trend in the old location 
 

To workaround this issue, call 
Application.Refresh after moving 
the symbol to redraw the display. 
The Refresh function should be 
used sparingly, since it may affect 
performance.  
Sub 

moveBatchGroupSymbol()  

BatchGroup1.Top = 

BatchGroup1.Top-500 

BatchGroup1.Applicatio

n.Refresh  

End Sub 
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SCR# 19941  The BatchGantt.SetTimeRange 
method does not correctly set 
the Gantt's time scale. Calling 
this method results in the Gantt 
bars' width and location not 
agreeing with the time scale 
displayed on the X axis.   

The 
BatchGroup.SetTimeRange 
function properly sets the time 
range of its contained Gantt 
and trends.  

SCR# 20181  Problems have been identified 
with the StartTime and 
EndTime properties on the 
BatchGantt and BatchGroup 
symbol. The BatchGroup 
StartTime and EndTime 
properties are always the same 
as the first contained 
BatchTrend, i.e., 
BatchGroup.Trends.Item(1). If 
there are no BatchTrends, the 
StartTime and EndTime 
properties of the BatchGroup 
are blank. The BatchGantt 
StartTime and EndTime 
properties are less reliable and 
should be avoided.  

None  

- ----------- Efforts have been taken to 
minimize the effect of PI 
BatchView 3.x on existing VBA 
code with PI BatchView 2.1 
displays. However, some 
methods no longer function in 
version 3.x. This is mostly due 
to the fact that batch alignment 
is treated differently with PI 
BatchView 3.x. There are no 
migration issues moving from 
version 3.0 to version 3.1.  
The VBA BatchAlign event 
does not fire with PI BatchView 
3.x.  
The definition of property 
BatchFormat.ShowTraceMarke
rs has changed. If the value is 
0, trace data markers are not 
displayed (off). If the value is 
not 0, trace data markers are 
displayed (on). Phase and Data 
markers are no longer 
supported.  
The property 
BatchTrendDef.Format.ShowB
atchMarkers is ignored (when 
BatchTrend.SetDefinition is 
called).  
The Plot Time (or Time Alias) 
definition from PI BatchView 

None  
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2.1 is ignored when upgrading 
the display to PI BatchView 3.x. 
The plots default to relative, 
plotting from batch start to 
batch end. Any changes made 
in PI BatchView 3.x are saved, 
but only for future use with PI 
BatchView 3.x. If the display is 
consequently read with PI 
BatchView 2.1, the old 
definition (as defined in PI 
BatchView 2.1) is used.  

--------- When a PI BatchView 2.1 
display is opened, all 
BatchTrend symbols are 
converted to a BatchGroup 
symbol containing the 
BatchTrend. The BatchGroup 
symbol maintains the name of 
the original symbol and the 
contained  BatchTrend’s name 
is the same as the BatchGroup 
with the prefix “BV21_”. For 
example, a PI BatchView 2.1 
display has a symbol called 
BatchTrend4. When opened in 
PI BatchView 3.x, the display 
has both a BatchTrend4 (the 
Batch Group) and 
BV21_BatchTrend4 (the Batch 
Trend) symbol     
 

None 

- ----------- VBA code written against PI 
BatchView 2.1 to add a batch 
trend now adds a batch group 
symbol. For compatibility, the 
first batch trend is referenced 
when accessing a BatchGroup 
object with a BatchTrend 
variable.  
Dim sym As Symbol  

Dim bt As BatchTrend  

Dim bg As BatchGroup  
Set sym = 

Symbols.Add(21)  

Debug.Print "sym.type=" 

& sym.Type  

‘output: sym.Type=21 

Set bt = sym ' Gets the 

first trend in the 

batch group.  
Debug.Print "bt.Type=" 

& bt.Type  

‘output: bt.Type=21  

Set bg = sym  

Debug.Print "bg.Type=" 

None 
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& bg.Type  

‘output: bg.Type=21 
  

 

- ----------- When upgrading a PI 
BatchView 2.1 display, the VBA 
call: 
ThisDisplay.Symbols.Item("Bat
chTrend1") finds the Batch 
Group symbol converted from 
the PI BatchView 2.1 Batch 
Trend symbol called 
"BatchTrend1". The “Type” 
property of a BatchGroup is 21 
(the PI BatchView 2.1 
BatchTrend.type property is 
also 21). The “Type” property 
of a PI BatchView 3.0 
BatchTrend is 26. For example:  
Dim bt As BatchTrend  

Set bt = 

Symbols("BatchTrend1")  

Debug.Print "bt.Type=" 

& bt.Type  

‘output: bt.Type=21  

Set bt = 

Symbols("BV21_BatchTren

d1")  

Debug.Print "bt.Type=" 

& bt.Type  

‘output: bt.Type=26  

None 
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Windows XP Problems  
 
(only observed when running PI BatchView on Windows XP)  

 
 

 

 

 

 

 

Abbreviation  Product  
PB  PI ProcessBook  

PT  PI ProcessTemplates  

 

Setup 

Operating Systems 

This release supports Windows XP, Windows 2003, Windows Vista, Windows 2008, and 

Windows 7 and Windows 8.  

System Prerequisites 

For PI ProcessBook features, you must be running PI ProcessBook version 3.1 or later. 

For the PI BatchView 3.x Microsoft Excel add-in, you must be running Microsoft Excel XP 

or later. 

The PI Server from which batch records are to be retrieved must be version 3.3.362.47 (3.3 

SR2) or greater to support PI BatchView. 

To view existing batch data stored in the Batch Subsystem in PI BatchView 3.x, you must 

first create copies of the units from the pibaunit table into the Module Database. This step is 

described in the document Batch Database Support of the PI Batch Subsystem found on the 

OSIsoft Tech Support website. See the section of the document titled “Accessing Batch 

Subsystem Batches via the PI SDK” for a step-by-step procedure. 

 

Punch List Item Description Workaround 

SCR# 21628  The Gantt scrollbar does not use 
the Windows XP format.  

None  

SCR# 5198  Several of the buttons on the 
Batch Definition dialogs appear in 
a 3-D style on Windows XP. The 
display and PI BatchView dialogs 
will be changed to use a 
consistent "Windows XP" style in 
a future release.  

None  

SCR# 5130  Portions of the background on the 
Batch Definition dialog are a 
different color than the rest of the 
dialog.  

None  

http://techsupport.osisoft.com/Products/Client+Products/PI+BatchView/Moving+to+the+PI+Batch+Database.htm
http://techsupport.osisoft.com/
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OSIsoft Prerequisite Kits are available in three packages that verify and install the needed 

operating system prerequisites:  

Online (Recommended): For installation on a computer connected to the internet. This kit 

connects to Microsoft sites in order to download .NET Framework 3.5 for the operating 

system on which it is run. This is a bootstrapper kit that is much smaller than the Standalone 

kit.  

Standalone (Recommended): For installation on a computer that cannot connect to Microsoft 

sites, or for installations where such connection is not desirable. This is a full redistributable 

kit that is much larger than the Online kit.  

Legacy: This kit should only be used for installation on older operating systems where the 

OSIsoft products do not require .NET Framework 3.5. 

All three Prerequisite Kits contain both 32-bit and 64-bit installation redistributables.   

See the Prerequisites Product Pages on the OSIsoft Tech Support Web site to determine 

which MS Operating System prerequisites you need: 

http://techsupport.osisoft.com/Products/Prerequisite+Kits/Prerequisite+Kits+Overview.htm 

Distribution Kit Files 

The PI BatchView is delivered as a self-extracting zip file named BatchView_2012_.exe.  This 

file contains:  

 BatchView_Setup.MSI 

 BatchView_Setup.mst 

 dotnet20Setup.dll 

 MDACSetup.dll 

 MSRuntimes.msi 

 MSRuntimes_318.msi 

 msxmlSetup.dll 

 PatchDLL.dll 

 PI BatchView 2012 Release Notes.pdf 

 Pibufss.msi 

 pisdk.msi  

 pisdk.mst 

 pisdk_x86_1.4.0.418.msp 

 PISDKRegistryPermissionFix_WI65835.dll 

 ScriptingRuntimeSetup.dll 

 Setup.exe 

 setup.ini  

 SetupUtils.dll 

 silent.ini 

 WindowsInstallerSetup.dll 

 

PI SDK is version 1.4.0.418  

http://techsupport.osisoft.com/Techsupport/NonTemplates/Download%20Center/DownloadCenter.aspx?download_file=C7115738-BA7A-4182-A01A-21CB941BFCE0
http://techsupport.osisoft.com/Techsupport/NonTemplates/Download%20Center/DownloadCenter.aspx?download_file=F5EE8436-6067-4DA0-9C36-84D1462D7E27
http://techsupport.osisoft.com/Techsupport/NonTemplates/Download%20Center/DownloadCenter.aspx?download_file=7C65398C-2AB2-4D9C-B920-E65146573226
http://techsupport.osisoft.com/Products/Prerequisite%20Kits/Prerequisite%20Kits.htm
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Installation and Upgrade 

Because the setup program  needs to write entries to shared portions of the registry and copy 

files to the system directory, you must run setup.exe while logged into the system as a user 

with Administrator privileges. As with all setup programs, it is advisable to close other 

applications during the setup process.  

 Install PI ProcessBook version 3.1.0.0 or later.  Note that earlier versions of PI 

ProcessBook are not supported for this version of PI BatchView, but you can use 

displays created in those versions.   
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 Install PI BatchView version 3.1.5 The setup program is an integrated package to 

install PI BatchView as well as other Windows and PI component software needed to 

run PI BatchView. All of the components are listed on the Setup Welcome screen 

along with a note on whether they need to be installed or upgraded.  All component 

installations are run in the sequence listed in the Setup Welcome; they are run silently 

when possible. When feasible, all system reboots are saved until the completion of 

the entire installation to avoid repeated reboots to the system.                                        

If the Windows Installer component needs to be installed, this component installation 

is run silently. Unfortunately, the system does not show an hourglass when the 

Windows Installer component setup is running, so it may appear to users that the 

system is hung during this portion of the setup. The setup is functioning correctly 

even when the hourglass does not appear.                                                                       

When the Microsoft Data Access Components (MDAC) need to be installed, the user 

is advised that the system needs to be rebooted upon completion of the installation of 

this component. Although this message suggests that the reboot occurs immediately, 

it does not happen until the very end of the entire installation. 

 Sometimes the setup program needs to display a dialog box with a message to the 

user and, in most cases, that window appears on top of all other open windows on the 

computer. In some cases, a dialog box is hidden behind another open window. You 

can select the window from the task bar at the bottom of the screen in order to bring 

it to the top. Once you bring the window to the top and respond, the installation 

continues normally.  

Note: Administrative (network shared) setup of PI BatchView 3.1 is not supported. Both PI 

ProcessBook and PI BatchView must be installed locally in order for PI BatchView to 

function correctly. 

Upgrading from a Previous Version  

General  

Migration from PI BatchView 2.1 to 3.x has been designed to be as seamless as possible. 

However, because of the advances in storing batches on the PI server, the client tools for viewing 

batch data have been improved and behaviors have changed. Therefore, the experience of 

working with batch-driven display is different, but offers more functionality than in the older 

versions.  

 

Upgrades from prior versions of PI BatchView 3.1.x to the most current version of PI BatchView 

are supported by the setup program. Upgrades from older versions of PI BatchView (3.0 and 

below) require the manual step of uninstalling the old version before running the PI BatchView 

setup kit. 

 

If you wish to upgrade from a timeout version of this software, follow the instructions for 

Downgrading to an Earlier Version. 

 

Excel Addin  
This version of PI BatchView ships with both the new version (3.1) and the previous version (2.1) 

of the Excel add-in.  

 

 The 2.1.1.2 version of the Excel add-in is included to support existing spreadsheets 

having BatchQuery and UnitAliasQuery functions. This version remains unchanged from 
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the PI BatchView 3.0.3 release. This add-in must be manually added to Excel if required. 

From Excel's Tools->Add-ins menu, choose "PI-BatchView" or browse to pibat32.xla in 

the \pipc\batch directory. 

 

 The new Excel add-in provides new functions to fully support the PI Batch Database and 

can be loaded side-by-side with the version 2.1 add-in, if desired. This add-in is 

automatically added to Excel during the installation of PI BatchView 3.1. This add-in 

contains two add-ins listed in Excel: "PI BatchView for Excel" and 

"PIBVExcel.Functions." Both are required for version 3.1 of the Excel add-in to work 

properly. 

Downgrading to an Earlier Version  

Downgrading PI BatchView requires that you uninstall PI BatchView 3.1 and PI ProcessBook. 

Since uninstall does not remove some of its files, they must be manually deleted before re-

installing PI BatchView and PI ProcessBook.  

 

Steps for downgrading:  
1. Uninstall PI BatchView 3.1.   

2.  Delete the Program Files\pipc\batch directory 

3. Uninstall PI ProcessBook (if it was installed). Optionally, you may: 

a. Delete Program Files\PIPC\procbook\btrend32.dll. 

b. )   Delete Program Files\PIPC\procbook\btrend.tlb. 

c. Delete all files in the Program Files\PIPC\Batch directory.  

d. Repair the PI ProcessBook installation. 

 

4. Install PI ProcessBook (if desired). 

5. Install the desired version of PI BatchView. 

 

Uninstalling PI BatchView 

PI BatchView can be removed from your system by selecting it for removal in the Add/Remove 

Programs utility in the Control Panel for Windows XP, and 2003, or the Programs and Features 

Control Panel for Windows Vista and 2008 Server. You must have administrator privileges on 

your machine to successfully uninstall PI BatchView on Windows XP or Windows 2003 Server.  
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List of Files Installed During Setup 

 

Directory  File  File Version  Assembly Version  

C:\Program 
Files\PIPC\Batch  

CustomNamesSettings.exe  1.0.0.140     

   OSIsoft.AxPIBatchCustomNam
esCtrls.dll  

1.0.0.140     

   OSIsoft.AxPIBatchResultsCtrls.
dll  

3.1.0.163     

   OSIsoft.AxPIBatchSearchCtrls.
dll  

3.1.3.2     

   OSIsoft.PIBatchCommon.dll  3.1.0.163     

   OSIsoft.PIBatchCustomNames
.dll  

1.0.0.140     

   OSIsoft.PIBatchCustomNames
Ctrls.dll  

1.0.0.140     

   OSIsoft.PIBatchDialogs.dll  3.1.0.163     

   OSIsoft.PIBatchResultsCtrls.dll  3.1.0.163     

   OSIsoft.PIBatchSearch.dll  3.1.0.163     

   OSIsoft.PIBatchSearchCtrls.dll  3.1.3.2     

   OSIsoft.ProcessBook.BatchVie
w.dll  

3.1.4.0     

   OSIsoft.ProcessBook.BatchVie
w.Controls.dll  

3.1.3.2     

   pbBatchView.dll  3.1.3.2     

   pibat32.xla  2.1.1.2     

   PIBatchCommon.dll  3.1.4.0     

   PIBatchCustomNames.dll  1.0.0.140     

   PIBatchCustomNamesCtrls.oc
x  

1.0.0.140     

   PIBatchDialogs.dll  3.1.1.164     

   PIBatchResultsCtrls.ocx  3.1.1.164     

   PIBatchSearch.dll  3.1.1.164     

   PIBatchSearchCtrls.ocx  3.1.3.2     

   PIBatchUtilities.ocx  3.1.1.164     

   pibatchv.ocx  2.1.0.46     

   PIBatchView.exe  3.1.4.0     

   PIBVExcel.dll  3.1.3.2     

   PIBVExcelCommon.dll  3.1.3.2     

   PIBVExcel.xla  3.1.3.3     

   PIBVExl.cnt        
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   PIBVExl.hlp        

   readme.htm        

C:\Program 
Files\PIPC\Procbook  

btrend32.dll  3.1.4.0     

C:\Program 
Files\PIPC\ 
Procbook\En  

btrend32.dll.mui  3.1.4.0     

 

Directory  File  File Version  Assembly Version  

C:\Program 
Files\PIPC\Help  

PI Batch Custom Names 
Settings.chm  

      

   PIBatchView.chm        

   PIBatchViewProgramming
.chm  

      

C:\Program 
Files\PIPC\Help\En  

PIBatchView.chm        

   PIBatchViewProgramming
.chm  

      

C:\Program 
Files\PIPC\DAT  

BatchViewMaster.log        

   pisetup_BatchView.ini        

   SetupBatchView_Setup.lo
g  

      

C:\Windows 
(%SystemRoot%)  

PIBV_HelpIcons.bmp        

C:\Windows\System32 
(%SystemRoot%\System3
2)  

SftTree_IX86_A_45.ocx  4.5.15.500     

   SSubTmr6.dll  3.1.0.5     

   ROBOEX32.dll  11.0.217.0     

Global Assembly Cache 
(c:\windows\assembly) . 
This section identifies the 
Assembly version  

OSIsoft.AxPIBatchCustom
NamesCtrls.dll  

1.0.0.140  1.0.0.0  

   OSIsoft.AxPIBatchResults
Ctrls.dll  

3.1.0.163  3.0.2.0  

   OSIsoft.AxPIBatchSearch
Ctrls.dll  

3.1.3.2  3.0.2.0  

   OSIsoft.PIBatchCommon.
dll  

3.1.0.163  3.0.2.0  

   OSIsoft.PIBatchCustomNa
mes.dll  

1.0.0.140  1.0.0.0  

   OSIsoft.PIBatchCustomNa
mesCtrls.dll  

1.0.0.140  1.0.0.0  

   OSIsoft.PIBatchDialogs.dll  3.1.0.163  3.0.2.0  

   OSIsoft.PIBatchResultsCtr
ls.dll  

3.1.0.163  3.0.2.0  

   OSIsoft.PIBatchSearch.dll  3.1.0.163  3.0.2.0  

   OSIsoft.PIBatchSearchCtrl
s.dll  

3.1.3.2  3.0.2.0  
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This product includes software (SSubTmr6.dll) developed by vbAccelerator (http://vbaccelerator.com/).  

 

Copyright (c) 2002 vbAccelerator.com  

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 

DISCLAIMED. IN NO EVENT SHALL VBACCELERATOR OR ITS CONTRIBUTORS BE 

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 

OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 

LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

 

  

   OSIsoft.PIBVExcel.dll  3.1.3.2  3.1.0.0  

   OSIsoft.PIBVExcelCommo
n.dll  

3.1.3.2  3.1.0.0  

   OSIsoft.ProcessBook.Batc
hView.Controls.dll  

3.1.3.2  1.0.0.0  

   OSIsoft.ProcessBook.Batc
hView.dll  

3.1.4.0  1.0.0.0  

C:\Program Files\Common 
Files\Designer\  

MSADDNDR.DLL  6.00.8169    

http://vbaccelerator.com/
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Documentation Overview 

PI BatchView User Guide: An introduction to PI BatchView for the end user. This user guide 

provides a product overview, installation procedures, a tutorial to acquaint you with the user 

interface for PI BatchView, and other topics to allow you to work with and troubleshoot PI 

BatchView. 

Batch Database Support of the PI Batch Subsystem Document: This document describes how 

the Batch Database and PI Batch Subsystem are supported, the impact on existing batch 

applications, and techniques to move to the PI Batch Database
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Technical Support and Resources 

For technical assistance, contact OSIsoft Technical Support at +1 510-297-5828 or 

techsupport@osisoft.com. The OSIsoft Technical Support website offers additional contact 

options for customers outside of the United States. 

When you contact OSIsoft Technical Support, be prepared to provide this information: 

 Product name, version, and build numbers 

 Computer platform (CPU type, operating system, and version number) 

 Time that the difficulty started 

 Log files at that time 

 Details of any environment changes prior to the start of the issue 

 Summary of the issue, including any relevant log files during the time the issue occurred 

The OSIsoft Virtual Campus (vCampus) website has subscription-based resources to help you 

with the programming and integration of OSIsoft products. 

  

http://techsupport.osisoft.com/
http://vcampus.osisoft.com/
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OSIsoft, LLC  
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San Leandro, CA 94577 USA 

Tel: (01) 510-297-5800 
Fax: (01) 510-357-8136 
Web: http://www.osisoft.com 

 

OSIsoft Australia • Perth, Australia 

OSIsoft Europe GmbH • Frankfurt, Germany 

OSIsoft Asia Pte Ltd. • Singapore  

OSIsoft Canada ULC • Montreal & Calgary, Canada 

OSIsoft, LLC Representative Office • Shanghai, People’s Republic of China 
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